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针对蛋白质分析的全面解决方案

Jess/Abby/Wes

全自动 Western

Milo

单细胞 Western

Ella

微流控全自动 ELISA

Maurice

CE-SDS + icIEF 双功能 CE

MFI 

微流成像颗粒计数分类仪

FluorChem

多功能成像

PROTEIN SIMPLE -- 创新蛋白质分析技术专家
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GEL-RUNNING AUTO 

TRANSFER-FREE

BLOT-FREE

HANDS-FREE

MEET SIMPLE WESTERN

1 Simple Western 工作原理

2 Simple Western 优势及应用

3 Simple Western 实验操作简介

超微量样品+自动化+定量

J E S S  A B B Y   W E S



© 2022 Bio-Techne®. All rights reserved.

您需要做的工作

1. 配制样品和试剂
• 加样
• 混匀
• 加热

3. 运行
•放毛细管卡盒
•放加样板
•运行程序

2. 加样
•加marker
•加样品
•加封闭液
•加一抗
•加二抗
•加发光液
•加洗液*样品不能加 Loading Buffer



*图片来源于网络
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运行结束后
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Compass 介绍 数据分析前检查 数据分析
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COMPASS 软件

COMPASS 有三个主要界面

• Assay – 实验前的设置

• Run summary – 运行过程中的实时情况

• Analysis – 分析界面
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ASSAY 界面
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ASSAY 界面

新建 Assay

打开 Assay

保存

另存为

导入 Protocol

导入 Template

导出 Protocol

导出 Template

打印（Protocol/Template）

退出软件
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ASSAY 界面

剪切

拷贝

粘贴

默认分析设置

默认分析预览

参数设置
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ASSAY 界面
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ASSAY 界面

Compass 软件用户手册

Simple Western 用户手册

检查更新

版本注释

导出仪器日志

发送 Run

Compass 软件相关信息
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RUN SUMMARY 界面
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RUN SUMMARY 界面

‣ 12–230 kit：1 kDa，29 kDa ，230 kDa

‣ 66–440 kit：57 kDa， 280 kDa

‣ 2–40 kit：1 kDa， 26 kDa
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RUN SUMMARY 界面
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RUN SUMMARY 界面

打开 run

增添 run

关闭

关闭所有 run

保存

另存为

导出报告

退出软件
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RUN SUMMARY 界面
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RUN SUMMARY 界面
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ANALYSIS 界面
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ANALYSIS 界面

打开 Run

增加 Run

关闭 Run

关闭所有 Run

保存

另存为

导出为表格

导出形式

导出报告

退出软件
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ANALYSIS 界面
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ANALYSIS 界面

荧光内参
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ANALYSIS 界面

荧光内参 样品
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ANALYSIS 界面

荧光内参 样品
展示选择
的毛细管
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ANALYSIS 界面

荧光内参 样品
展示选择
的毛细管

展示所有毛细管Wes

Abby
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ANALYSIS 界面
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ANALYSIS 界面
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ANALYSIS 界面

荧光内参 样品
展示选择
的毛细管

展示所有毛细管Wes

Jess

化学发光

Abby
Probe 1

Probe 2
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ANALYSIS 界面

荧光内参 样品
展示选择
的毛细管

展示所有毛细管Wes

Jess

化学发光

NIR

IR

总蛋白
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ANALYSIS 界面

荧光内参 样品
展示选择
的毛细管

展示所有毛细管Wes

Jess

化学发光

NIR

IR

总蛋白
归一化

Replex

Abby
Probe 1

Probe 2
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ANALYSIS 界面
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ANALYSIS 界面

实验窗格
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ANALYSIS 界面

实验窗格

不同结果视图
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ANALYSIS 界面

峰型图

• 峰形图信息量最大，

数据质量分析推荐

用峰形图

• 选择不同的通道，

将有不止一个Y轴

• 点击 Auto Scale     

将自动调整所有毛

细管的量程
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ANALYSIS 界面

峰型图

自动校正

• 峰形图信息量最大，

数据质量分析推荐

用峰形图

• 选择不同的通道，

将有不止一个Y轴

• 点击 Auto Scale     

将自动调整所有毛

细管的量程
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ANALYSIS 界面

峰型图

结果堆叠展示

• 峰形图信息量最大，

数据质量分析推荐

用峰形图

• 选择不同的通道，

将有不止一个Y轴

• 点击 Auto Scale     

将自动调整所有毛

细管的量程
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ANALYSIS 界面

峰型图

结果合并展示

• 峰形图信息量最大，

数据质量分析推荐

用峰形图

• 选择不同的通道，

将有不止一个Y轴

• 点击 Auto Scale     

将自动调整所有毛

细管的量程
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ANALYSIS 界面

峰型图

• 峰形图信息量最大，

数据质量分析推荐

用峰形图
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将有不止一个Y轴
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细管的量程



© 2022 Bio-Techne®. All rights reserved.

ANALYSIS 界面

• 毛细管实际曝光结

果

• 选择“Show All 

Images”后若信号

过曝，毛细管曝光

图中将出现红色像

素点（Compass 

v6.1.0）

成像图
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泳道图

ANALYSIS 界面

• 大部分报告的结果形

式

• 可以任意显示或横向

移动泳道

• 可以单独调整每个通

道的对比度

– 对比度调整仅改变图片

中条带呈现效果, 峰定

量结果不变
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泳道图

ANALYSIS 界面

对比度调节
• 大部分报告的结果形

式

• 可以任意显示或横向

移动泳道

• 可以单独调整每个通

道的对比度

– 对比度调整仅改变图片

中条带呈现效果, 峰定

量结果不变
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泳道图

ANALYSIS 界面

反相

• 大部分报告的结果形

式

• 可以任意显示或横向

移动泳道

• 可以单独调整每个通

道的对比度

– 对比度调整仅改变图片

中条带呈现效果, 峰定

量结果不变
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泳道图

ANALYSIS 界面

荧光内参
• 大部分报告的结果形

式

• 可以任意显示或横向

移动泳道

• 可以单独调整每个通

道的对比度

– 对比度调整仅改变图片

中条带呈现效果, 峰定

量结果不变



© 2022 Bio-Techne®. All rights reserved.

ANALYSIS 界面

实验窗格

不同结果视图
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ANALYSIS 界面

实验窗格

不同结果视图

峰统计数据表
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ANALYSIS 界面

实验窗格

不同结果视图

峰统计数据表

分析选项窗格
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Compass 介绍 数据分析前检查 数据分析

01 02 03
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数据分析前检查

• 请确保在查看数据前，先通过几个部分的检查确认实验没有问题，包括荧光内参确认、

Ladder确认、数据质量确认

– 荧光内参整齐并识别良好

– Ladder 识别良好

– 化学发光信号无过曝

– 荧光通道相机无饱和（Jess）

– 背景无过高

– 峰面积正常
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1. 荧光内参整齐



© 2022 Bio-Techne®. All rights reserved.

1. 荧光内参整齐
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‣ 12–230 kit：1 kDa，29 kDa ，230 kDa

‣ 66–440 kit：57 kDa， 280 kDa

‣ 2–40 kit：1 kDa， 26 kDa

1. 荧光内参整齐
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1. 荧光内参整齐

Compass 软件一般能自动识别校正荧

光内参，但是偶尔也会识别不正确

荧光内参识别不正确，将导致分子量

计算错误
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2. LADDER 识别良好
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1. 如果 ladder 峰识别错误, 点击右键进行校正

₋ 注意您的 ladder 通道要选择正确

2. LADDER 识别良好

2. 如果有一个 ladder 峰不可见, 可能调整下视野

₋ 点击 View→ View Region ，选择 Full Range，

可查看整个毛细管的视野数据

3. 如果不能通过识别来校正某个 ladder 峰

点击 Edit → analysis →ladders.  

₋ 如有必要，移除某个Ladder；或选择 “none” 关闭 ladder 选项

* 在没有 ladder 识别的情况下, Compass 软件依赖于每个毛细管内的荧光内参进行分子量计算
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3. 化学发光信号无过曝
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3. 化学发光信号无过曝

• 曝光默认模式是 HDR

• HDR 模式对独立的曝光

时间进行计算，得出最

大动态范围，最低背景

的信号



© 2022 Bio-Techne®. All rights reserved.

3. 化学发光信号无过曝

• 化学发光信号实际上是信号/时间的比值.

– 在长曝光时间中，信号衰减，所以峰高下降

• 如果您看到在前几个曝光时间中，某个峰的信号明

显下降，说明:

– 化学发光底物消耗完

– 该信号超出了动态范围

• 保持化学发光的峰高小于300,000

正常信号

过曝信号
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4. 荧光通道相机无饱和（JESS）

• 在 NIR 通道中，信号太强有可能导致相机

像素饱和

• 一旦观察到信号开始下降，说明相机饱和，

最小的两个曝光时间峰应该重叠，否则说明

相机较快饱和

• 分析数据时，建议选择HDR模式

• 保证荧光检测的峰高低于 60,000
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5. 背景无过高——基线拟合

• 软件默认显示扣除背景后的信号曲线 (背景设为0)

• 要观察基线, 需要勾选 “Baseline fit”；基线参数设置在 Edit→Analysis...中

• 软件根据基线下面的点拟合出基线，可添加或删除基线点
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5. 背景无过高——基线拟合

• 为什么高背景是个问题?

– 信号饱和风险

– 显著减弱动态范围

– 降低检测灵敏度

样品 一抗
毛细管号

峰序号 迁移位置峰名 分子量 峰高 峰面积
相对峰面积

峰宽 信噪比 基线拟合
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5. 峰面积正常
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• 灰色部分的面积即峰面积.

• 需确认拟合峰跟实际峰形拟合良好

• 右键单击可通过 “add peak” 或 “remove 

peak” 增加或去除峰

• 在 analysis 菜单中，可选择拟合方式, 包

括 gaussian fit（高斯拟合）vs dropped 

lines（垂直拟合，推荐总蛋白定量时使用）

5. 峰面积正常
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• 灰色部分的面积即峰面积.

• 需确认拟合峰跟实际峰形拟合良好

• 右键单击可通过 “add peak” 或 “remove 

peak” 增加或去除峰

• 在 analysis 菜单中，可选择拟合方式, 包

括 gaussian fit（高斯拟合）vs dropped 

lines（垂直拟合，推荐总蛋白定量时使用）

5. 峰面积正常

阈值

峰宽
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数据分析前检查

• 确认完成了以下检查

✓ 荧光内参整齐并识别良好

✓ Ladder 识别良好

✓ 化学发光信号无过曝

✓ 荧光通道相机无饱和（Jess）

✓ 背景无过高

✓ 峰面积正常
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数据分析前检查

• 确认完成了以下检查

✓ 荧光内参整齐并识别良好

✓ Ladder 识别良好

✓ 化学发光信号无过曝

✓ 荧光通道相机无饱和（Jess）

✓ 背景无过高

✓ 峰面积正常

可以开始分析数据了
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Compass 介绍 数据分析前检查 数据分析

01 02 03
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编辑实验信息

• 样品及抗体信息等在 Assay 界面输入

– Assay template 里输入的信息可以随时更改（运行前/后）

• 右键点击可隐藏泳道

• 如果要显示隐藏的泳道，点击: 

– View→Show Hidden

– 右键点击 unhide 恢复
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选择检测通道

• 毛细管/泳道可选择性浏览或者全局浏览

• 检测通道可进行开/关

• 选择不同的通道，将有不止一个Y轴
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峰命名

当您查看数据时，标记您的峰值很有帮助

• 选项 1: 右键点击峰形图
中的峰，选择 Name 
Peak → New…进行命名

• 选项 2: Analysis Options 
窗格里

–在 Name 中: 下拉选中
[New]

–输入峰名称等

–单击 Create

• 选项 3: 右键点击峰
统计表中的峰，选择
Name Peak →
New…进行命名

• 选项 4: 在Edit > 
Analysis 菜单栏中

– 在 Peak Names 
栏中进行峰命名
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峰命名
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峰命名
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泳道图

ANALYSIS 界面

对比度调节

• 大部分报告的结果形

式

• 可以任意显示或横向

移动泳道

• 可以单独调整每个通

道的对比度

– 对比度调整仅改变图片

中条带呈现效果, 峰定

量结果不变
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能否直接注释结果？
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能否直接注释结果？

?
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COMPASS 6.0.0 版本
适用于 W E S / J E S S / A B BY
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COMPASS (V.6 .0 .0)  主要更新

•添加了Lane 结果注释
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•添加了Lane 结果注释

• “New Assay” 仅适用于 (Abby/Jess/Wes)

• 采用了新的信噪比（S/N）分析方法

COMPASS (V.6 .0 .0)  主要更新
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保存，不用每次打开再重新编辑
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•添加了Lane 结果注释

• “New Assay” 仅适用于 (Abby/Jess/Wes)

• 采用了新的信噪比（S/N）分析方法

• 在 Graph 界面进行的编辑已可以

保存，不用每次打开再重新编辑

• 基线校正的选项移动到 Lane 界面的 Graph 
Options内

• 支持多种格式保存结果（TIF/JPG/PNG）

*兼容模式– Compass 6.0 版本能打开以前Jess/Wes的文件

COMPASS (V.6 .0 .0)  主要更新
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释

新建注释
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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注释结果名，单击可更改

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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新建注释

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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复制注释

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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导出注释结果（TIF/PNG/JPG）

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释



© 2022 Bio-Techne®. All rights reserved.

删除该注释结果

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — CROP
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可以自定义分子量范围

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — CROP
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可以自定义分子量范围
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可以自定义分子量范围
自定义通道

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — CROP
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可以自定义分子量范围
自定义通道

自定义对比度

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — CROP
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — LANE LABELS
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Lane 标签可使用
Assay 界面实验设计，
也可以自己重新编辑

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — LANE LABELS
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自定义标签位置，分组，旋转角度等

Lane 标签可使用
Assay 界面实验设计，
也可以自己重新编辑

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — LANE LABELS
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自定义标签位置，分组，旋转角度等

Lane 标签可使用
Assay 界面实验设计，
也可以自己重新编辑

分组标签位置

合并标签
标签位置

下划线/上划线

旋转标签

标签换行

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — LANE LABELS
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — BAND LABELS
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条带标签可使用已命名的目
的峰也可以重新编辑

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — BAND LABELS
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条带标签可使用已命名的目
的峰也可以重新编辑

自定义条带位置和
展示形式

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释 — BAND LABELS
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只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释
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• Add Run – 同时打开多个运行文件结果不能使用 Lane 注释功能

• Access Control – 受管控的运行文件不能使用 Lane 注释功能

• Graph view – 不能注释电泳图，只能注释泳道图

• Fonts – Lane 工具暂不支持所有类型的字体

只 需 在 C O M PA S S  内 即 可 进 行 注 释

LANE 注释功能目前的局限
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导出数据

• 图像拷贝

– 在峰形图或者泳道图中，右键点击Copy 复

制或保存图像

• 数据拷贝

– 选中峰统计表中的行（一行或多行），右键

点击 Copy 复制数据

• 点击 File→export tables

– 软件将建立一个文件夹导出各类统计数据

• 点击 File→run report

– 软件将建立一个 PDF 文档，详细报告图和表
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公众号咨询/报修流程



© 2022 Bio-Techne®. All rights reserved.

PROTEINSIMPLE
SIMPLE YOUR PROTEIN ANALYSIS

Maurice

• Simple icIEF + CE-SDS

MFI

• Simple Particle Analysis

Ella

• Simple ELISA

Jess/Wes/Abby

• Simple Western

Milo

• Simple Sc-Western

FluorChem

• Simple Imaging

4000-863-973



QUESTIONS
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